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Introduction to WebCT 

Introduction to WebCT 
 

What is WebCT? 
 
WebCT (Web Course Tools) are a set of: 
 
• educational tools for facilitating learning, communicating and collaborating through the use 

of the Internet and computers; 
• content building utilities for organizing course materials; 
• administrative utilities for managing and continuously improving a course; and 
• design utilities for constructing the course (colour schemes, page layout, etc). 
 

How Did WebCT Begin? 
 
WebCT began in 1994 as a university project, conducted by Murray Goldberg, a faculty member 
at the University of British Columbia. Murray’s objective was to create an interactive web-based 
environment for a 3rd year computer science course. In 1995, the University of British Columbia 
awarded Murray Goldberg a grant to develop Web Course Tools as a way to apply innovative 
technologies to facilitate course preparation and enrich students' learning experiences. Working 
with Sasan Salari, Murray developed a product so well received by his peers that they launched 
the product commercially in 1997. 
 
In May 1999, WebCT joined forces with Universal Learning Technology. The combined 
company, under the leadership of President and CEO Carol Vallone, expanded rapidly. 
 
In January 2000, it launched webct.com, the e-learning hub, which, when used in combination 
with WebCT, maximizes the online teaching and learning experience. 
 

Advantages of WebCT 
 
WebCT allows you to: 
 
• Teach courses your way at your own technological comfort level. 
• Create, maintain, and add course materials interactively through the Web.  
• Assess student performance at any time during the course.  
• Quickly update and change course content. 
• Restrict access to specified materials until a certain level of learning is achieved or a date is 

reached 
• Have students participate at any time. 
 

WebCT:  Just the Basics 2 



Introduction to WebCT 

Logging in to WebCT 
 
To access the WebCT site, you must type in the following address or URL in your web browser:   
 

webct.stu.ca 
 
 
NOTE:   You do not need to include an http:// or www. at the beginning of this address.   
 

Logging Out 
 
Browsers remember ID’s and passwords.  When you are finished using WebCT you should log 
out to insure that no one else can use your account.  If you do not log out, the next person who 
uses the computer can log  in to WebCT using your ID and password.  That person may not even 
realize it.  While this may not be a problem if you do not share a computer, logging out is still a 
good habit to get into.    
 
To Log out of WebCT:   
 
1. Click Logout at the top of any WebCT screen.   
 
Alternately, you may close all browser windows.  This will achieve the same result.   
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WebCT Login Page 
 
This page is the WebCT server login page. A server is the main computer where all course 
information is stored. This login page is also a gateway to many resources for both students and 
the faculty. 
 

 
 
Login to WebCT – This button will take you to a page where you can enter your username and 
password to log in.   
 
Frequently Asked Questions (FAQs) – The FAQ is a list of questions that WebCT users 
commonly have.  This is a good place to look for an answer to your WebCT problems before you 
contact support.   
 
Contact Us – Click this link to open your mail program and send an email to the WebCT 
administrators.
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Creating a Syllabus in WebCT 
 
Courses based on the standard template already have the Syllabus tool.  Once you 
have access to a course, you can modify the syllabus tool as you wish. 
 
1. At your Homepage, click the Course Syllabus icon.  
2. Select Designer Options to make edits. 
 
All of the functions that allow you to customize the syllabus will appear on the right of your 
screen.  There are two ways to create a syllabus in WebCT:   Using the built-in templates, or 
using an existing file from a word processor.  We will look at using the templates first.    
 

Creating a Syllabus using the Templates 
 
The built in templates are an easy way to create simple syllabi in WebCT. To add information to 
the syllabus using the templates, follow these steps:   
 
1. From the course Homepage, click on the Course Syllabus icon.   
2. Make sure that Syllabus Tool is selected under Syllabus Source on the right.  Initially, the 

syllabus should have no sections in it.   
3. Under Options: Syllabus Tool, pick a syllabus section from the drop down list and then click 

Add.  For this example, let’s pick Course Information.   
4. The screen will refresh and provide you with the template for that section.  Fill out the 

information and then click the Add button.  The Course Information screen looks like this:   
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 Every section must have a title.  The section title is usually used to describe what this section is 
about.  You can leave the default title for now, but you may wish to change it later.   If a 
particular field doesn’t apply, leave it blank.  WebCT will not display a blank field.   
 
NOTE:   Any fields marked with a red * are required and must be filled out.    
 

Editing a Syllabus 
 
If you need to make changes to a syllabus after you have already added a section, follow these 
steps:   
 
1. In the Syllabus Tool, click on the blue text for the title of the section you wish to edit.  For 

this example, click on the words “Course Information”.  When you enter the syllabus tool, 
you should see a list like the following that displays all the sections currently in the syllabus.   

 

 
 
2. A screen will appear that looks exactly like the screen that appeared when you added the 

section.  Only this time, it has the information that you entered before.   
3. Make your changes on this screen, and when you are satisfied, click Update.   
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Uploading a Syllabus File 
 
Many professors already have their syllabus typed in Word or WordPerfect.  While you can copy 
and paste the information out of these files into the WebCT Syllabus template, you may also use 
these files directly in WebCT.   
 

Prepare the Content 
 
Before you upload the syllabus into WebCT, it should be converted to HTML.  Converting the 
syllabus to HTML insures that students will be able to view the syllabus.  If a word processing 
document is uploaded and students do not have that word processor, they will not be able to view 
the syllabus.   
 
The following example uses the file “syl2003-4.wpd” but you may use your own syllabus file.     
 
1. Open the file “syl2003-4.wpd” in WordPerfect.   
2. From the File menu, select Publish To and then HTML.  The Publish to HTML dialog will 

appear.   
 

 
3. Click the browse button (  ) next to the HTML File Name box.  The Open In dialog will 

appear.   
4. Select Desktop from the Look In drop-down list.   
5. Click the Open button.  
6. Click Publish.   
7. Close WordPerfect.   
 
NOTE:   If your file is a Microsoft Word file, you can also convert it to HTML.  Instead of 

Publish to HTML, you would select Save as Web Page from the File menu in 
Microsoft Word.   
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Upload the File 
 
Once you have the HTML file created from WordPerfect, you’re ready to upload it into WebCT.   
 
1. From the course Homepage, click on the Course Syllabus icon.  The Syllabus screen should 

appear.  
 

 
 
2. Make sure that Syllabus File is selected under Syllabus Source (on the right of the screen).   
3. Click the Browse button.  The File Browser will appear.   
4. Near the bottom of the file browser window is a sectioned titled Upload File.  In this section, 

click the Browse button.   
 

 
 
5. Locate the syllabus file that you converted earlier.  It should be the file with the .htm or .html 

extension.  For our example, the file should be “syl2003-4.htm” and it should be located on 
the desktop.   

6. Click the Open button.   
7. Make sure My-Files is selected in the Upload to: box and then click Upload.   
8. You file should then appear in the top section of the File Browser under the My-Files folder.  

Notice that the file is already selected.   
9. Click the Add Selected button.  The File Browser will close.   
10. Click Update.   
 
 To see what the syllabus will look like to the students, click on the View tab at the top of the 
screen.   
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Using the WebCT HTML Editor 
 
Once a syllabus is posted to a course, it may be necessary to make changes to it.  There are two 
ways that this can be done:  The original document can be edited, converted to HTML and then 
uploaded again to WebCT; or you can use the built-in HTML editor to change the document 
from within WebCT itself.   
 
To use the built-in HTML editor:   
 
1. From within the course, click Control Panel.   
2. In Control Panel click Manage Files. 
3. Locate your syllabus file within Manage Files and then click on its name.  The Edit File 

screen will appear.   
4. Click the HTML editor button located near the bottom of the screen.  It may take from 

several seconds to a minute for the HTML editor to load, so be patient.  Once the HTML 
editor loads, your screen should look similar to the following:   

 

 
 
This screen is very much like a word processor. Experiment with the formatting options 
available to see what each ones does.  When you are satisfied with your changes, click the 
Update button to save the changes.  You may also abandon the changes you made by clicking the 
Cancel button.   
 
WARNING:   If you do not click Update your changes will not be saved!!   
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Deleting Files 
 
There may come a time when you want to remove a file from WebCT that you uploaded.  
Removing unneeded files from WebCT helps keep your My-Files area organized, and frees up 
space for others to use.   
 
To delete files, follow these steps.   
 
1. From inside the course, click Control Panel. 
2. In Control Panel click Manage Files.   
3. In Manage Files, click the checkboxes next to the files you wish to delete and then click on 

the Delete button on the right under Options:  Files.   
4. You will be presented with the Delete Files screen.  Along the left are the files that you 

selected to be deleted and on the right are a Delete and Cancel button.   
5. When you click Delete all the files that are selected on the left will be deleted.   
 
WARNING:   Be careful when deleting files!  Once you delete a file from WebCT it is gone and 

cannot be retrieved.  There is no Recycle Bin or Undelete.   
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Entering Grades 
 
WebCT and Datatel at Saint Thomas University are closely integrated.  When it comes time to 
enter midterm or final grades, they may be entered directly into and through WebCT.  
 
There are at least two things that you should think about before you begin: 
 

1. In the Datatel environment, we use "Midterm Grade" only for the Christmas grade for 
the first section of a full-year course.  In WebCT, you may record as many midterm 
grades as you choose, but you should only export into Datatel that one category of 
midterm grades.  (At Saint Thomas University we break full-year courses into two 
sections.) 

 
2. Also, TA's can record grades for you but they do not have access to the "export" 

functions. 
 
Follow these steps to enter a midterm or final grade:   
 
1. From inside your course in WebCT, click on Control Panel.   
 
2. In Control Panel under Manage Course click on the link for Manage Students.   The 

Manage Students (Grade Book) will appear.   
 

 
 
3. Under either the Midterm Grade or Final Grade column, click on the Edit link.  The Edit 

Column Values screen will appear.  
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4. Enter the grades in the spaces provided.  
 

 
 

5. When you are finished, click Update.   
 
If you made a mistake entering the grades, simply repeat the above process and on the Edit 
Column Values screen, make your changes and then click Update.    
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Submitting Grades 
 
Very Important:  You can only submit grades once through WebCT.  Make sure you have 
entered all the grades correctly before doing the following steps!   
 
1. From the Manage Students (Grade Book), Under the Options: Advanced drop-down list, 

select Export midterm grades or Export final grades and click Go.  
 
The Export Grades screen appears. 
 

 
 

2. Select the checkbox in the table heading row to select all students or check beside individual 
students to send just those selected.   
 

 
 
3. Click Export midterm grades or Export final grades. A confirmation screen appears.  
 

NOTE:  You can only export student grades once, so be certain you are ready to do this!   
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4. Click OK. The screen will update to tell you that the grades have been submitted.   
 

 
   
 
NOTE:  Although you can only submit grades once from WebCT, you may still update your 
grades from WebAdvisor if required.  If you change grades in WebAdvisor after submitting them 
through WebCT those changes will also be reflected in the grades shown in WebCT.   
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Sharing Designer Access 
 
In order for you to work on a course that does not belong to you, the owner of the course must 
share her designer access with you.  As a shared designer, you have all the same privileges as the 
owner, with one exception:  you are not able to share access with someone else.   
 
To make someone a shared designer, follow these steps:   
 
1. In the course, click on Control Panel.   
2. In Control Panel under the Manage Course column, click on the link for Share Access.  The 

Designers with Shared Access screen appears.   
3. On the right under Options, enter the WebCT ID of the person with whom you wish to share 

access.  (A WebCT ID is the same as a STU email ID.) 
4. Click the Add button.  The new shared designer will be listed on the left of the screen.  
 

Remove a Shared Designer 
 
When you no longer need to have access to your course shared, you may remove shared 
designers by using the Share Access course management function.   
 
1. In the course, click on Control Panel.   
2. In Control Panel under the Manage Course column, click on the link for Share Access.  The 

Designers with Shared Access screen appears.   
3. Click the checkbox next to the WebCT ID of the person from whom you wish to remove 

shared access.   
4. Click the Delete button on the right.   
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